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SAŽETAK: 

 

Kroz ovaj diplomski rad biti će obrađena i opisana tehnika fotografiranja – dvostruka 

ekspozicija. To je fotografska tehnika kod  koje dolazi do preklapanja dviju ili više 

fotografija na jednom snimku.  U teorijskom dijelu rada pisat će se općenito o 

fotografiji te će biti opisani počeci korištenja ovakve tehnike kroz povijest i njen utjecaj 

na društvo, osvrnut će se na najpoznatija djela i umjetnike ove grane fotografije. 

Poseban je naglasak na kreativnom aspektu i mogućnostima koje pruža korištenje 

dvostruke ekspozicije i kako se očituje u finalnom izgledu fotografije. U 

eksperimentalnom dijelu korištene su tri metode dobivanja dvostruke ekspozicije: 

digitalno, klasičnim fotografskim aparatom i pomoću programa Adobe Photoshop. Cilj 

rada je vlastitim fotografijama potkrijepiti i primijeniti teoretska saznanja i time 

prikazati različite  postupke dobivanja dvostruke ekspozicije. Ovim se radom i 

popratnim istraživanjem nastoji predstaviti i usporediti tehnike dvostruke ekspozicije, 

počevši od samih početaka dobivanja iste u analognom fotoaparatu, preko odabira 

opcija ugrađenih u digitalnom aparatu, pa sve do modifikacije fotografija u nekom od 

programa za obradu fotografija. 

 

Ključne riječi: fotografija, dvostruka ekspozicija, klasični fotografski aparat, digitalni 

fotografski aparat, Photoshop 

 

 

 

 

 

 

 



 
 

ABSTRACT: 

 

Through this thesis will be discussed and described techniques of photography - double 

exposure. This is a photographic technique in which two or more images overlap in one 

shots. In the theoretical part of the work will be written generally about photography 

and will be described the beginnings of the use of these techniques throughout history 

and its impact on society, will look at the most famous works of the artists of this 

branch of photography. Particular emphasis is on the creative aspect and the 

possibilities offered by the use of double exposure and that is reflected in the final 

appearance of the photo. In the experimental part were used three methods of obtaining 

double exposure: digital, classic camera and using Adobe Photoshop. The aim is to 

substantiate with their own photographs and apply the theoretical knowledge and thus 

show different methods of making a double exposure. This paper and accompanying 

study aims to present and compare the technique of double exposure, starting from the 

beginning to obtain the same in the analog camera, through selecting the built-in digital 

camera, to the modification of photos in one of the programs for photo editing. 

 

Keywords:  photography, double exposure, classic camera, digital camera, Photoshop 

  



 
 

 

SADRŽAJ 

 

1. UVOD………………………………………………………………………..1 

2. TEORETSKI DIO………………………………………………………..…..2 

    2.1 Povijest dvostruke ekspozicije…………………………………….......…2 

3. DVOSTRUKA EKSPOZICIJA.......................................................................8 

    3.1 Razumijevanje dvostruke ekspozicija……….……………………….…..9 

4. METODE DOBIVANJA DVOSTRUKE EKSPOZICIJE……………....…10 

    4.1 Klasična metode……………………………………………………..…10 

        4.1.1 Prilikom snimanja………………………...……………………..…10 

        4.1.2 Fotografski laboratorij…………………………………………..…10 

    4.2 Digitalna metoda…………………………………………………..…...11 

    4.3 Korištenje programa………………………………………………..…..15 

5. EKSPERIMENTALNI DIO………………………………………………..16 

    5.1 Postupak izrade klasičnim fotografskim aparatom………………...…..18 

    5.2 Postupak izrade digitalnim  fotografskim aparatom……………….…..21 

    5.3 Postupak izrade računalnim programima……………………….……...26 

6. ZAKLJUČAK…………………………………………………………..….34 

7. LITERATURA………………………………………………………….…35 

 

 

 

 

 

 



1 
 

1. UVOD 

 

Fotografija je moćan medij kada je u pitanju stvaranje iluzije jer ju publika doživljava 

kao nešto vjerodostojno. U današnje vrijeme u fotografiji postoji puno različitih i 

kreativnih tehnika fotografiranja koje nude mnoštvo različitih mogućnosti za 

stvaralačko ili kreativno izražavanje. Kroz ovaj rad bazirat ćemo se na jednu od tih 

tehnika fotografiranja - dvostruku ekspoziciju.  

Ovakva tehnika snimanja dvostruke ekspozicije nije nikakav novitet među fotografima, 

poznata je još od samog početka postojanja fotografije. Do njenog otkrića došlo je 

sasvim slučajno no tada se na nju gledalo kao na pogrešku koja je mogla nastati 

prilikom fotografiranja. Početak njenog razvoja dogodio se u klasičnoj fotografiji, no 

zbog svoje privlačnosti nastavlja se razvijati i primjenjivati u digitalnoj fotografiji u 

kojoj  i doživljava najvišu točku razvoja. [1] 

Radi se o tehnici fotografiranja kod koje dolazi do preklapanja dvije ili više različitih 

motiva unutar jednog fotografskog kadra gdje dolazi do stvaranja potpuno novih scena. 

Primjenom dvostruke ekspozicije prilikom fotografiranja, moguće je stvoriti različite 

efekte kao što su dupliciranje motiva, zrcalne slike, ili jednostavno spajanje dvaju 

kadrova različitih motiva kako bi se dobile potpuno nove slučajno ili namjerno 

manipulirane scene. Potrebe za korištenjem ovakve tehnike mogu varirati, ali je ona 

zasigurno stvorena za istu namjenu – prikazivanje ljepote i jedinstvenosti motiva. [2] 

Dvostruku ekspoziciju moguće je dobiti na više načina: uzastopnim snimanjem dva ili 

više puta na negativu, u laboratoriju korištenjem dva različita negativa tzv. sendvič 

fotografija, u digitalnim fotografskim aparatima ili da se, u digitalnim programima kao 

što su Adobe Photoshop, Pixlr Editor itd, preklapaju dvije različite fotografije. [3] 

 

 

 

 

 

http://apps.pixlr.com/editor/
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2. TEORETSKI DIO 

 

2.1 POVIJEST DVOSTRUKE EKSPOZICIJE 

 

Ubrzo nakon izuma fotografije, prije otprilike 200 godina, fotografski pioniri svijeta 

razišli su se u dva smjera. Jedna skupina fotografa krenula je u  dokumentiranje svijet 

koji ga je okruživao. Druga je otišla u drugom smjeru i posvetila se eksperimentiranju s 

fotografijom. U to vrijeme tokom fotografiranja dužina eksponiranja je znala trajati čak 

i duže od pola sata te se za to vrijeme znalo dogoditi da se objekti koje snimamo ili sami 

fotograf pomaknu, i to bi u konačnici rezultiralo stvaranjem dvostruke slike. Zbog 

takvih događaja moglo bi se reći da je tehnika otkrivena sasvim slučajno. Nakon tog 

otkrića polovica fotografa pokušavala je izbjeći pojavu dvostruke slike  dok ju  je druga 

polovica započela istraživati i koristiti u kreativne svrhe za stvaranje zanimljivih 

fotografija. Time je započela jedna nova fotografska tehnika koja je još dan danas u 

razvoju. 

 Tehnički gledano takve fotografije nisu dobivene dvostrukom ekspozicijom nego 

dugačkim eksponiranjem te se pomoću toga manipuliralo fotografijama u njenim 

počecima. [1] 

 „Ghosting“ (od engleske riječi ghost, što znači duh) efekt nastaje uslijed fotografiranja 

s dugačkim ekspozicijama te ako se objekt koji se snima u trenutku eksponiranja filma 

promjeni svoj položaj. Kako je ostatak kadra mirovao na fotografijama će se primijetiti 

mutni i prozirni obrisi objekta koji se pomicao, što je najčešće rezultiralo time da se 

kroz objekt koji se u trenutku snimanja pomaknuo djelomično vidi pozadinski kadar te 

tako nalikuje na duha. Odnosi se na vrstu fotografije čiji je glavni cilj bio hvatanje 

duhova na fotografijama te ima snažnu povijest koja datira s kraja 19. stoljeća. [4] 

Ovakvu vrstu fotografije prvi puta upotrijebio  je Williama H. Mumler 1860. godine. 

Nakon što je snimio fotografiju primijetio je da se na snimku nakon razvijanja nalazi još 

jedna osoba. Uvidjevši da postoji potražnja za takvim fotografijama počeo ih je 

izrađivati iz jedne osnovne fotografije koju je kombinirao s negativima kako bi dodao 
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osobu na konačnu sliku. Njegova prevara je otkrivena kada je počeo koristiti živuće 

stanovnike kao duhove koje su klijenti prepoznali. [4] 

 

 

Slika 1: Mary Todd Lincoln s duhom supruga, Abraham Lincolna 

http://www.usatoday.com/story/news/nation-now/2015/10/29/abraham-lincoln-ghost-portrait/74841948/ 

 

Još jedan od pionira tzv. spiritualne fotografije bio je i fotograf William Hope. Istakao 

se u spiritualnim krugovima zbog svoje navodne sposobnosti da uhvati duhove na 

svojim fotografijama. Hope je, s vremenom, osnovao grupu spiritualista koje je nazvao 

"Crewe Circle". Skupina je zarađivali na ožalošćenoj porodici koja je izgubile svoje 

voljene u Prvom svjetskom ratu. (slika 2.) [5] 

 

 
 

Slika 2: Porteret ožalošćene rodbine 

https://publicdomainreview.org/collections/the-spirit-photographs-of-william-hope/ 

 

https://en.wikipedia.org/wiki/Mary_Todd_Lincoln
https://en.wikipedia.org/wiki/Abraham_Lincoln
http://www.usatoday.com/story/news/nation-now/2015/10/29/abraham-lincoln-ghost-portrait/74841948/
http://www.vice.com/photo
https://en.wikipedia.org/wiki/Crewe_Circle
https://publicdomainreview.org/collections/the-spirit-photographs-of-william-hope/


4 
 

 

Slika 3: The Ghost of Bernadette Soubirous, iz 1890.g. 

https://www.enlightapp.com/blog/history-double-exposure-photo-contest-win-iphone-6/ 

 

 

Početkom 20. stoljeća avangardni umjetnici su prihvatili tehniku i počeli su 

eksperimentirati sa dvostrukom ekspozicijom te su se upustili u kreiranje inovativnih 

fotografija kombinirajući različite kompozicije kako bi dobili inovativne rezultate. U 

svojim djelima željeli su se odmaknuti od realističnog prikaza te su naglašavali 

neobično u običnom i poznatom. [6] 

Godine 1924. dolazi do stvaranja umjetničkog pokreta, nadrealizma koji se počeo širiti i 

obuhvaćati sve grane vizualne umjetnosti pa tako i samu fotografiju. Potpomogao je 

istraživanju ljudske podsvijesti, igru asocijacija i maštovitost.  Mnogi umjetnici su se u 

tome pronašli što je rezultiralo ubrzanim razvojem nadrealističke fotografije.  Fotografi 

su se usmjerili stvaranju osjećaja nestvarnosti na fotografijama. Najčešća tehnika kojom 

su se koristili kako bi dobili nadrealni izgled u fotografijama je dvostruka ekspozicija.  

Fotograf koji je ostavio najjači trag na nadrealističkim fotografijama zasigurno je  Man 

Ray.  Svojim eksperimentiranjem i umjetničkim djelovanjem proširio je granice 

fotografije kao nitko do tada. Na svojim fotografijama volio je koristiti dvostruku 

ekspoziciju, raslojavanja te solarizaciju kako bi stvorio što nadrealniji izgled. [7] 

Brisanjem razlike između stvarnog i fantastičnog, na fotografijama su se nudile vizualne 

predstave između živog i neživog vukući gledatelje u svoj čudnovati pomalo uvrnuti 

https://www.enlightapp.com/blog/history-double-exposure-photo-contest-win-iphone-6/
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svijet. Fotografi su pod utjecajem nadrealizma, kao što su Maurice Tabard, izlagati 

ljudsku figuru do narušavanja i transformacija eksperimentirajući s fotografskim 

tehnikama, bilo da se radilo za vrijeme snimanja slike ili tokom razvijanja u 

fotografskom laboratoriju. [8] 

 

 

Slika 4 : Markiza Castati; Man Ray, 1922. g. 

https://www.nyfa.edu/student-resources/wp-content/uploads/2014/10/ManRay2-711x1024.jpg 

 

Maurice Tabard je bio jedan od vodećih fotografa pokreta nadrealizma, koji je ušao pod 

utjecajem svog prijatelja, američkog fotografa Man Raya. Kao i Ray u izradi fotografija 

se koristio dvostrukom ekspozicijom, tehnikom solarizacije te montažom negativa u 

svrhu dobivanja nadrealnih fotografija. Bio je dominantna ličnost u avangardnoj i 

modernističkoj fotografiji. Njegove fotografije su ga afirmirale kao vizionarskog 

umjetnika. 

Njegovo eksperimentiranje s fotografijom dovelo ga je do toga da je postao jedan od 

važnijih avangardnih fotografa iz tog vremena. [9] 
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Slika 5: Untitled, Maurice Tabard 

https://s-media-cache-ak0.pinimg.com/564x/25/b6/ed/25b6edace32ed1d73f510683874f381e.jpg 

 

1925. godine nakon što je uveden novi 35mm format negativa, fotografi tog doba su se 

ponovo vratili trendu izrade dvostruke ekspozicije u fotografskim laboratorijima. Takav 

proces izrade se naziva sendvič fotografija, dva negativa polažu se u uređaj za 

povećanje kojeg se upotrebljavalo prilikom izrade konačne slike. Takva mogućnost 

kombiniranja jednog negativa sa drugim  dala je umjetnicima opciju puno preciznijeg i 

detaljnijeg preklapanja slike. Jedan od primjera tako nastalih fotografija je spajanje 

autoportreta talijanske fotografkinje, Wande Wulz i portreta mačke. Stvorila je 

zadivljujuću kompoziciju tako što je koristila dva negativa - jedno od portreta, a drugo 

od mačke – u fotografskom laboratoriju na jednom listu fotografskog papira pokušala je 

dočarati besprijekornu kombiniranje identiteta koji se s takvom lakoćom pojavljuju u 

svijetu snova. (slika 6.) 
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Slika 6: Io + Gatto Self-portrait; Wande Wulz, 1932.godina 

https://ofcourseitsallluck.wordpress.com/ 

 

Ulaskom u 21. stoljeće dolazi do razvoja tehnologije i započinje novo razdoblje koje 

nas uvodi u digitalno doba. Dolaskom digitalnih fotografskih aparata, pametnih telefona 

s raznim aplikacijama i i programima za digitalnu obradu fotografija, danas je moguće u 

potpunosti preskočiti dugotrajne procese za dobivanje fotografije putem klasičnog 

fotografskog aparata. Takav napredak u tehnologiji omogućio nam je bržu i 

jednostavniju daljnju obradu fotografija koja do sada nije bila moguća standardnim 

fotografskim tehnikama. [6] 
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3. DVOSTRUKA EKSPOZICIJA 

 

U povijesti fotografije otkriven je širok raspon fantastičnih tehnika i specijalnih efekata 

koji su doprinijeli znanosti i umjetnosti te našem načinu gledanja okoline koja nas 

okružuje. Pomoću takvih eksperimentalnih tehnika stvorio se jedan posve drugačiji i 

maštovitiji pristup stalnom traženju novih motiva, te novi način prezentacije 

tradicionalne fotografije. [10] 

Dvostruku ekspoziciju možemo objasniti kao svaku fotografiju na kojoj su motivi 

barem dva ili više puta eksponirani. Kada je riječ o dvostrukoj ekspoziciji u klasičnoj 

fotografiji onda se to odnosi na eksponiranje jedne scene te ponovnim eksponiranjem 

druge scene na istome snimku, bilo da se radi u fotografskom laboratoriju ili u samome 

fotografskom aparatu. Kod upotrebe digitalnih fotografskih aparata u svrhu dobivanja 

dvostruke ekspozicije postupak ostaje isti samo što se umjesto negativa nalaze digitalni 

senzori te se sada na njih izvršava eksponiranje. 

Ovom tehnikom se može ostvariti manipuliranje stvarnosti, izraziti različite emocije i 

vizualne poruke ili ju koristiti samo kako bi dodali različite detalje. Daje sasvim novi 

pristup u snimanju uobičajenih i svakodnevnih tema. Otvara cijeli svijet neočekivanim i 

nevjerojatnim rezultatima formirajući posve drugačiju vizualnu priču. [11] 

Upotrebljavanje i kreiranje pomoću tehnike dvostruke ekspozicije započelo je još u 

doba klasične fotografije te je i za nju specifičnija. Danas u digitalno doba kada je došlo 

do razvoja tehnologije ovakva tehnika doživljava pravi procvat i ima sve veću upotrebu 

u digitalnoj fotografiji. U svojim početcima imala je primjenu samo u umjetničkoj 

fotografiji, no danas je sve raširenija i koristi se u privatne, komercijalne i reklamne 

svrhe, od amatera pa sve do profesionalaca. [12] Kako je mogla stvoriti osjećaj pokreta 

na fotografijama postala je popularna i među sportskim i plesnim fotografima. Danas je 

mnogi umjetnici koriste kako bi siluetama dodali teksturu ili kako bi portrete dopunili s 

različitim motivima i time im produbili značenje. 
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3.1 Razumijevanje dvostruke ekspozicije 

 

 

Prilikom snimanja dvostrukih ekspozicija, osim potrebnog znanja i opreme potrebno je 

razumjeti neke tehničke odredbe koje su neophodno prilikom snimanja ne bi li napravili 

što kvalitetnije fotografije. Kako bi se što bolje upravljalo s dvostrukom ekspozicijom 

potrebno je pravilno koristiti pozitivne i negativne vrijednosti fotografije. Te negativne i 

pozitivne vrijednosti možemo prevesti kao preeksponirani i podeksponirani dijelovi. 

[11] 

Preeksponirani dijelovi na fotografiji prikazuju svijetle dijelove i takva područja nije 

moguće prekriti s drugom ekspozicijom. Podeksponirani odnosno tamni dijelovi 

predstavljaju područja na koja nije palo dovoljno svijetla te su ostali nedovoljno 

osvijetljeni. Zbog tih karakteristika takva podeksponirana područja su idealna za 

naknadna osvjetljavanje s drugim motivima koji popunjavaju te praznine .  

Tom drugom ekspozicijom (koja bi trebala biti svjetlija) se tada mogu ti tamniji dijelovi 

popuniti svijetlim tonovima i tako dobivamo ravnotežu, različite kontraste i teksture 

ujedinjene na jednoj fotografiji. To je razlog zašto su siluete fantastičan odabir za 

dvostruke ekspozicije, dok sunčano nebo ili pretjerano svijetli krajolik mogu proizvesti 

fotografiju koja djeluje jako isprano. U pravilu se prvo fotografira tamnija scena, kako 

bi te tamne dijelove još mogli naknadno osvijetliti s drugom svjetlijom scenom. [13] 

 

 

 

 

 

 

 

 



10 
 

4. METODE DOBIVANJA DVOSTRUKE EKSPOZICIJE 

 

4.1 Klasične metode 

 

Ako govorimo o dobivanju dvostruke ekspozicije klasičnim putem na filmu tada se 

misli na dobivanje pomoću fotografskog aparata ili u fotografskom laboratoriju 

prilikom povećavanja negativa. 

 

  4.1.1 Prilikom snimanja 

Kod samog snimanja klasičnim fotografskim aparatom postoji više načina kako koristiti 

dvostruku ekspoziciju. Jedan od načina, koji je ujedno i najčešći, je korištenje opcije 

zaustavljanja filma nakon okidanja koje nude sami fotografski aparati. Kod takvog 

načina prije nego što izvršimo eksponiranje povlačimo ručicu koja služi za zaustavljanje 

negativa  (klasični fotografski aparati s ručnim navijanjem filma) ili se samo uključuje 

opcija (fotografski aparati koji imaju automatsko premotavanje filma).  

U prvom slučaju, kod aparata s ručnim navijanjem filma, nakon što zaustavimo 

navijanje filma okidamo prvi snimak i izvršimo eksponiranje jednog kadra zatim 

navijemo film i ponovimo eksponiranje na isti snimak. Kada završimo s okidanjima 

otpuštamo film i navijemo film na novi snimak. U drugom slučaju ako ne postoji 

zaustavljač negativa tada se nakon što prvi puta eksponiramo snimak pritišće gumb za 

premotavanje filma unatrag u podnožju kamere te oslobodimo mehanizam za 

transportiranje negativa. Pomaknemo ručicu za navijanje filma i zatim ponovimo 

eksponiranje. [10] 

Kod fotografskih aparata s automatskim navijanjem s postojećom funkcijom koja 

prekida takvo automatsko navijanje uključuje se prije snimanja  te se zatim izvršava 

prva ekspozicija i zaustavlja film na istom snimku da bi se mogla okinuti još jedan 

snimak na postojećem. Kod automatskih kamera koje nemaju ugrađenu funkciju za 

dvostruku ekspoziciju potrebno je ispucati cijeli film dokraja, zatim ga premotati na 

početak  i natrag vratiti u fotografski aparat i ponovo na njega snimati. Kako se ne zna 
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kako će se snimke spojiti ovakav način snimanja daje nepredvidljive i iznenađujuće 

rezultate. [1] 

 

  4.1.2 Fotografski laboratorij 

Kako bi u fotografskom laboratoriju dobili dvostruku ekspoziciju potrebno je prilikom 

povećanja kombinirati dva ili više negativa. Prvo se na fotografski papri osvijetli jedan 

negativ nakon čega se stavlja drugi negativ i kroz njega se vrši ponovno eksponiranje 

fotografskog papira. Druga mogućnost postizanja efekta je kombiniranjem dvaju 

negativa prilikom povećavanja (sendvič negativ). Uvjet je da su oba negativa koja 

koristimo prilikom eksponiranja dovoljno transparentna kako ne bi došlo do gubitaka 

dijelova. 

Ovakva metoda  omogućuje više slobode prilikom kombiniranja kadrova. Pruža 

mogućnost postizanja snažnijih, sadržajem slikovitijih fotografija. Prilikom 

eksponiranja moguće je dodatno nadosvjetliti ili zadržati dijelove. [12] 
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4.2 Digitalna metoda 

 

U današnje digitalno doba, kada su fotografski aparati u svome razvoju dosegnuli 

tehnološke vrhunce sve više SLR aparata se počinje proizvoditi s već ugrađenom 

funkcijom koja omogućava izradu dvostrukih ekspozicija. Funkcija "Mutliple exposure" 

(engl. Višestruka ekspozicija) omogućuje direktno snimanje višestrukih ekspozicija u 

samome fotografskom aparatu. Pojedini modeli nude isključivo dvije ekspozicije, dok 

neki noviji modeli nude i veći broj eksponiranih kadrova. 

U izborniku, odabirom opcije Multiple exposure otvaraju nam se daljnje opcije kako bi 

koristili višestruku ekspoziciju. (slika 7.) 

 

 

Slika 7: opcija Multiple exposure u izborniku (Canon) 

http://learn.usa.canon.com/resources/articles/2011/1dx_multiple_exposures_article.shtml#page3 

Prva Func/Ctrl nudi zasebno eksponiranje dviju kadrova koji naknadno mogu biti 

provjereni na LCD ekranu te se nudi opcija zasebnog namještanja ekspozicija za svaku 

fotografiju u trenutku snimanja. „Live view“ odnosno pregled uživo je itekako koristan 

jer omogućuje da se svaka nadolazeća slika ukomponira u elemente prethodno 

snimljene fotografije, daje bolji uvid u konačan izgled fotografije te se mogu izbjeći 

moguće pogreške.   

Digitalni fotografski aparati rade na principu namještanja opcija u samome 

fotografskom aparatu. U izborniku se odaberu željene opcije i aparat je spreman za 

snimanje. Pritiskom okidača se snima prva ekspozicija nakon koje se zatvarač zatvara. 

Nakon ponovnog otvaranja zatvarača se snima druga ekspozicija. Rezultat je dvostruko 

http://learn.usa.canon.com/resources/articles/2011/1dx_multiple_exposures_article.shtml#page3
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eksponirana digitalna fotografija temeljena na principu načina dvostrukog eksponiranja 

kod klasičnih fotografskih aparata. [14] 

 

 

Slika 8: Maxim Trudolubov 

http://weburbanist.com/2012/03/26/double-vision-33-examples-of-multiple-exposure-photography/ 

Druga opcija ContShtng odnosi se na brzo i kontinuirano snimanje. Koristi se najčešće 

za snimanje objekta u pokretu koje nakon snimanja kamera ujedini u jednu jedinstvenu 

fotografiju. 

Proizvođač digitalnih fotografskih aparata Canon pruža različite dodatne opcije stapanja 

(blending). (slika 9.)  

Additive - opcija kod koje se prvo snimi jedna fotografija zatim druga s time da ta druga 

fotografija ima određenu prozirnost kako bi se dobio efekt dvostruke ekspozicije.  

Average - opcija služi kod točnog proračunavanja idealne ekspozicije za oba kadra. 

Bright (comparative) - ovaj princip daje prioritete ekspoziciji na svijetlim objektima 

tako da će zadržati svoju osvijetljenost čak i ako su u kombinaciji s tamnom pozadinom. 

Kada se tamni objekti kao što je noćno nebo, zgrada ili stablo preklapaju, njihova 

svjetlina se neće povećati. 

http://weburbanist.com/2012/03/26/double-vision-33-examples-of-multiple-exposure-photography/
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Dark (comparative) - Ova opcija može biti posebno korisna za uklanjanje svijetlih 

istaknutih dijelova ili odbljesaka koji mogu biti nepoželjni u sceni. Ovaj način rada daje 

prednost ekspoziciji na tamnim objektima, tako da će sačuva njihovu osvijetljenost čak i 

kada je u kombinaciji sa svjetlom pozadinom. [14] 

 

 

Slika 9: Opcije Blanding (Canon) 

http://learn.usa.canon.com/resources/articles/2011/1dx_multiple_exposures_article.shtml#page3 

 

 

Slika 10: Image Overlay (Nikon) 

http://www.nikonusa.com/en/learn-and-explore/article/ga5bvjav/image-overlay-combining-images-together-in-

camera.html 

 

Neki digitalni fotografski aparati, poput Nikona D7100, nude opciju korištenja i 

spajanja već postojećih fotografija. Kod Nikona opcija se zove "Image overlay" pomoću 

koje je moguće odabrati dvije već postojeće fotografije koje se nalaze na memorijskoj 

http://learn.usa.canon.com/resources/articles/2011/1dx_multiple_exposures_article.shtml#page3
http://www.nikonusa.com/en/learn-and-explore/article/ga5bvjav/image-overlay-combining-images-together-in-camera.html
http://www.nikonusa.com/en/learn-and-explore/article/ga5bvjav/image-overlay-combining-images-together-in-camera.html
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kartici te ih automatski spojiti jednu preko druge. (slika 10.) Svaki proizvođač želi 

ponuditi nešto novo što se tiče opcija kako bi se zadržao i istaknuo na postojećem 

tržištu. Zbog toga se ovisno od proizvođača do proizvođača razlikuju opcije koje 

posjeduje fotografski aparat. [15] 
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4.3 Korištenjem programa 

 

Zadnja opcija izrade dvostruke ekspozicije koju ćemo obraditi je korištenje računalnih 

programa za obradu slike kao što je Adobe Photoshop. U zadnje vrijeme, zbog svoje 

jednostavnosti prilikom izrade, ovakav način dobivanja efekata dvostruke ekspozicije 

postaje sve popularniji kako među profesionalnim fotografima tako i među amaterima. 

Takvi programi omogućavaju veću kreativnost i mogućnosti kontrole prilikom izrade. 

Kod preklapanja fotografija u nekom od računalnih programa, koriste se slojevi kojima 

se na različite načine može proizvesti fotografija slična onoj koja je dobivena pomoću 

fotografskog aparata. Fotografije se stavljaju u zasebne slojeve (layer) te se zatim 

mijenja prozirnost svakog sloja kako bi se postigao što bolji efekt dvostruke ekspozicije. 

Ovisno o tome što želimo dobiti i koju fotografiju želimo više naglasiti, mijenjamo 

prozirnost od jedva vidljive do vrlo slabe prozirnosti. Prilikom rada koriste se i različite 

metode stapanja (blend mode) koji određuje kako će se koji sloj ponašati s obzirom na 

druge slojeve. (slika 11.) 

 

 

Slika 11: Blend mode, Adobe Photoshop (autorska fotografija) 
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Radi se o jednostavnom postupku izrade, ali uspješnost najviše ovisi o fotografijama 

koje će se preklapati. Kod odabira fotografija s kojima će se raditi potrebno je birati 

dvije fotografije koje su različito eksponirane kako bi se dobio što bolji efekt. Na 

fotografijama bi trebao biti što veći kontrast između svijetlih i tamnih područja, kao što 

su siluete. Tamna područja služe kao sredstvo koje prenosi detalje sa druge fotografije. 

Danas, osim Adobe Photoshop-a postoji veći broj računalnih programa koji nude 

mogućnost izrade dvostruke ekspozicije. Također sve više je i aplikacija za mobitele 

koji nude bržu i jednostavniju izradu dvostrukih ekspozicija. Programe kao što je Adobe 

Photoshop možemo objasniti kao digitalizirana verzija fotografskog laboratorija. Što su 

prije fotografi izrađivali u fotografskim laboratorijima danas se to može brže i 

jednostavnije izraditi u takvim računalnim programima. 
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5. EKSPERIMENTALNI DIO 

 
 

 
Kroz moguće tehnike dobivanja dvostruke ekspozicije u eksperimentalnom dijelu rada 

su napravljene autorske fotografije koje se temelje na teoretskoj obradi teme dvostruke 

ekspozicije na fotografiji. Cilj ovog istraživanja je praktično prikazati teoretske ideje 

višestrukih ekspozicija, od klasične  izrade do digitalnih tehnika. 

Prvo će se korištenjem klasičnog fotografskog aparata snimati dvostruka ekspozicija. U 

ovoj metodi bitno je nakon okidanja prvog kadra (tamnijeg) zaustaviti navijanje filma, 

tako da se ponovnim okidanjem (svjetlijeg kadra) ponovno eksponira isti dio filma. 

Druga tehnika se odnosi na dobivanje dvostruke ekspozicije korištenjem digitalnog 

fotografskog aparata. Kod takve metode dvostruka ekspozicija dobivena je na način da 

nakon okidanja prve ekspozicije, u određenom vremenskom roku do ponovnog 

otvaranja zatvarača, promijenimo kadar i ponovo okinemo. Treća tehnika se odnosi na 

obradu fotografija u programu Adobe Photoshop. Prilikom snimanja korišten je klasični 

fotografski aparat na ručno navijanje Mamiya i digitalni fotografski aparat Nikon.  Za 

digitalnu obradu i montiranje fotografija korišten je računalni program Adobe 

Photoshop CS6.  
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5.1 POSTUPAK IZRADE KLASIČNIM  FOTOGRAFSKIM 

APARATOM 

 

Za potrebe izrade dvostruke ekspozicije korišten je fotografski aparat Mamiya 645, s 

objektivom 80 mm, 1:2.8.  (slika 12.) 

 

Slika 12: Mamiya 645 (autorska fotografija) 

Sa bočne strane fotografskog aparata nalazi se poluga pomoću koje se uključuje 

snimanje višestrukih ekspozicija i kada se poluga pomakne na Multi tada je omogućeno 

snimanje višestrukih ekspozicija. (slika 13.) 

 

Slika 13:  Postavke za omogućavanje dvostrukih ekspozicija (autorske fotografije) 

Na postavku Multi moguće je postaviti prije ili nakon početnog eksponiranja. Nakon što 

pomaknemo polugu  pritisnemo okidač i okinemo prvu fotografiju.  Nakon što smo prvi 
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puta eksponirali, ručicu za premotavanje filma navijemo te ponovnim pritiskanjem 

okidača vršimo eksponiranje drugog snimka preko prvoga. Kako je zaustavljen 

mehanizam za premotavanje negativa, negativ ostaje na istom snimku i ponovnim 

eksponiranjem dolazi do stvaranja dvostruke ekspozicije. Ovaj postupak se može 

ponavljati onoliko puta koliko mi to želimo sve dok je poluga postavljena na Multi. 

Nakon što polugu vratimo u početni položaj zaustavlja se snimanje višestrukih 

ekspozicija. 

 

Slika 14: Portret snimljen dvostrukom ekspozicijom (autorska fotografija) 
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Slika 15: Arhiektura u tehnici dvostruke ekspozicije (austorska fotografija) 

 

Slika 16: Detalji (autorska fotografija) 
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5.2 POSTUPAK IZRADE DIGITALNIM FOTOGRAFSKIM 

APARATOM 

 

Za potrebe izrade dvostruke ekspozicije korišten je fotografski aparat Nikon D7100, s 

objektivom 18- 105 mm, 1:3.5 – 5.6 (slika 17.) 

 

Slika 17: Nikon D7100  

Fotografski aparati Nikon DSLR nude dva načina kombiniranja ekspozicija: 

Multiple Exposure (nalazi se u izborniku snimanja) i Image Overlay (nalazi se u 

izborniku Retouch). Glavna razlika između ovih dviju postavki je ta da prvi način stvara 

kompozicije od slika snimljenih u tom trenutku, a drugi kombinira dvije postojeće slike 

sa iste memorijske kartice - bez obzira na to da li su u tom trenutku snimljene ili su 

mjesec ili čak godinu prije snimljene - ostavljajući izvorne slike netaknute.  

Na stražnjoj strani Nikona, pritisnite gumb Izbornik (Menu) u gornjem lijevom kutu. 

Koristeći višenamjensku tipku za odabir, pritisnite strelicu prema dolje da biste se 

kretali kroz različite opcije i kako bi došli do izbornika snimanja (Shooting menu). 

(slika 18.)  

 

Slika 18: Izbornik na Nikonu (autorske fotografije) 
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Pritisnite desnu strelicu i idi te prema dolje dok ne dođete do opcije Višestruke 

ekspozicije (Multiple Exposure). (slika 19.) 

 

  

Slika 19: Izbornik snimanja (autorske fotografije) 

 

Nakon što označimo Multiple exposure pritisnemo desnu strelicu kako bi ušli u izbornik 

te kako bi uključili opciju snimanja višestrukih ekspozicija. Kod uključivanja nude nam 

se opcija izrade serije višestrukih ekspozicija - On (series) ili izrada samo jedne 

višestruke ekspozicije - On (single photo).  

Kod opcije On (series) snimanje višestrukih ekspozicija se nastaviti sve dok ne 

isključimo opciju. On (single photo) normalno snimanje će se nastaviti automatski 

nakon kreiranja jedne višestruke ekspozicije. (slika 20.) Nakon što odaberemo jednu od 

opcija pritisnemo tipku OK. 

 

 

Slika 20: Opcija dvostruke ekspozicije (autorska fotografija) 
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Uključivanjem opcije višestruke ekspozicije otvaraju nam se dodatne opcije koje je 

potrebno namjestiti prije samog početka snimanja. Pritiskom strelice prema dolje 

dolazimo do opcije za namještanje broja ekspozicija na snimku. Za promjenu broja 

snimaka, pritisnite bilo gore ili dolje tipku dok se ne odabere željeni broj (možete birati 

između dva ili tri snimka). Zatim pritisnite gumb OK. (slika 21.) 

 

 

Slika 21: Namještanje broja ekspozicija (autorska fotografija) 

 

Sljedeća ponuđena postavka je Auto Gain.. Auto Gain je automatska kompenzacija 

ekspozicije za višestruku ekspoziciju. Fotoaparat automatski podešava ekspoziciju za 

svaki kadar čime se osigurava da se kadrovi ne eksponiraju pretjerano. (slika 22.) 

Postoje prednosti određivanja ekspozicija ručno, ali za početak je najbolje da se Auto 

Gain ostavi uključenim. Ako se odlučite isključiti ovu opciju, morat ćete prilagoditi 

izloženost pomoću otvora, brzine zatvarača ili ISO osjetljivosti. 

 

  
 

Slika 22: Automatsko namještanje ekspozicije (autorske fotografije) 
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Nakon što smo namjestili sve opcije možemo početi sa snimanjem. Izaberemo željeni 

kadar, izvršimo okidanje i odmah nakon prvog okidanja se prebacujemo na novi kadar 

kako bi napravili sljedeću fotografiju sa drugom ekspozicijom. Razmak između dva 

eksponiranja je maksimalno 30 sekundi, nakon toga automatski se isključuje i briše prva 

fotografija. Kod nekih fotografskih aparata kao što je Nikon D7100 kada je uključena 

opcija  Live View (LV) tada je nemoguće namjestiti opciju snimanja višestrukih 

ekspozicija. Kako bi omogućili uključivanje te opcije potrebno je promijeniti tu 

postavku iz Live View na Single (S), Continuous Low (CL) ili Continuous High (CH). 

(slika 23.) 

 

 

Slika 23:Dodatne postavke (autorska fotografija) 

 

Slika 24: Detalj (autorska fotografija) 
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Slika 25: Portret sniman dvostrukom ekspozicijom (autorska fotografija) 
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5.3 POSTUPAK IZRADE S RAČUNALNIM PROGRAMIMA  

 

Kreiranje dvostruke ekspozicije u programima u zadnje vrijeme postalo je sve 

popularnije te se sve više primjenjuje. Jedan je od najjednostavnijih načina dobivanja 

dvostruke ekspozicije na fotografijama. Postoji više načina pomoću kojih se može 

dobiti ovakav efekt, no u ovom radu će biti opisana dva postupka izrade u programu 

Adobe Photoshop CS6. Glavna prednost stvaranja ovog efekt u takvim digitlnim 

programima je to što se može isprobavati s više fotografija sve dok se ne dobiju 

odgovarajući rezultati te time daje veću kontrolu nad konačnim izgledom fotografije .  

Prvi korak u tom procesu je odabir odgovarajućih dviju fotografija, po mogućnosti 

različitih ekspozicija kako bi se mogle što bolje stopiti jedna s drugom i tako dobiti 

dvostruka ekspozicija.  

Za početak potrebno je otvoriti odabrane fotografije (File > Open) svaku u zasebnom 

sloju. (slika 26.) 

 

 
 

Slika 26: Otvaranje fotografija u Adobe Photoshop CS6 (autorska fotografija) 

 

Nakon što se u programu odaberu i otvore fotografije potrebno je uskladiti njihove 

veličine i piksele kako bi obje fotografije bile jednakih dimenzija. Image -> Image size 

(slika 27.) 
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Slika 27: Usklađivanje veličina (autorska fotografija) 
 

 

Nakon toga označimo fotografiju, no potrebno je prvo odrediti koja će biti baza 

ekspozicije odnosno s kojom fotografijom ćemo preklapati drugu fotografiju. 

Selektiranje fotografija izvodimo pomoću Rectangular Marquee alata. (slika 28.) 

Pomoću alata Move fotografiju koju smo odabrali da će se nalaziti iznad, nakon 

selektiranja prenosimo na baznu fotografiju i tako ih pozicioniramo da se nalaze točno 

jedna iznad druge.  

 

             

Slika 28: Selektiranje fotografija (autorska fotografija) 
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Slika 29: Odabir efekata (autorska fotografija) 

 

Nakon što smo prebacili fotografije jednu na drugu, gornji sloj odnosno fotografija koja 

se nalazi iznad ostaje aktivna kako bi se s njom moglo dalje manipulirati. Kada je sve 

namješteno pokrećemo Layer > Layer Style > Blending Options ili na desnoj strani 

programa otvaramo izbornik Layer gdje nam se dalje nude različite mogućnosti 

manipuliranja fotografijom. (slika 29.) Otvaranjem tog izbornika nude nam se razne 

opcije i mogućnosti koje se mogu namještati sve dok se ne dođe do željenih rezultata. 
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Slika 30: Gotova fotografija s efektom dvostruke ekspozicije (autorska fotografija) 
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Opisana je jedna od mogućnosti izrada dvostruke ekspozicije u Photoshopu, no program 

nudi još različitih mogućnosti prilikom izrade takvih fotografija. 

Drugi način pomoću kojeg je također moguće dobiti dvostruku ekspoziciju, nešto je 

kompleksniji i potrebno je izdvojiti nešto više vremena  kako bi se dobio željeni efekt. 

Kod ovakvog postupka u prvom koraku izvodi se izdvajanje objekta iz pozadine 

pomoću Quick Selection alata. U ovom slučaju, fotografija koja će ići preko druge 

fotografije je portret koji se nalazi ispred zida koji je potrebno ukloniti prije spajanja 

fotografija. (slika 31.) 

    

Slika 31: Izdvajanje objekta iz pozadine (autorske fotografije) 

 

Nakon što izoliramo objekt ostaju oštri nedefinirani rubovi te je potrebno još dodatno 

obraditi kako bi dobili što prirodniji rubovi oko objekta. U tom slučaju koristimo alat za 

precizno definiranje rubova Refin Edge. (slika 32.) Select > Refin Edge 

 

Slika 32: Definiranje rubova (autorske fotografije) 
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Sljedeći korak koji slijedi je prebacivanje fotografije u sloj nad postojećom baznom 

fotografijom.  U ovom koraku moguće je podesiti odnose između fotografija dajući 

slobodu prilikom pomicanja i pozicioniranja fotografija. Kako bi se što bolje vidjelo 

kako se fotografije poklapaju  potrebno je smanjiti neprozirnost (Opacity) gornje 

fotografije te ih zatim rasporediti kako želimo. 

 

 

Slika 33: Preklapanje fotografija (autorske fotografije) 

Nadalje se nastavlja isti proces kao i u prošlom primjeru - Layer > Layer Style > 

Blending Options gdje se postavke dalje namještaju do željenih rezultata. 

 

Slika 34: Miješanje slojeva (autorska fotografija) 
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Nakon što smo spojili i stopili fotografije jednu sa drugom moguće je dodati različite 

dodatne efekte kao što je smanjenje kontrasta, prebacivanje u crno bijelu, korištenje 

različitih dodatnih filtera i dr. 

 

 

Slika 35: Gotova fotografija (autorska fotografija) 
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Slika 36: Različiti načini miješanja slojeva (autorske fotografije) 
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6. ZAKLJUČAK 

 

Fotografija je oblik vizualnog medija kojim bilježimo vjerodostojni prikaz stvarnosti. U 

ovom slučaju fotografija kao takva odmaknuta je od uobičajenog i tradicionalnog 

prikazivanja. Stvoren je sasvim drugačiji i kreativniji pristup traženju motiva. 

Kreativnost koju posjeduje dvostruka ekspozicija je beskonačna. Ovom tehnikom 

fotografima je omogućeno stvaranje iluzija koje nisu bile moguće sve do jednog 

slučajnog otkrića, još na samom početku razvoja fotografije. Dvostruka ekspozicija je 

tokom povijesti prošla kroz raznolike eksperimente koji su je unaprijedili i poboljšali ne 

samo u tehničkom smislu već i u likovnom.  

Ovakav način preklapanja fotografija omogućio je stvaranje jedinstvenih i maštovitih 

fotografija. Pruža sasvim nove mogućnosti stvaranja kompozicija, dodavanja tekstura, 

stvaranja motiva koji lebde ili prolaze jedni kroz druge. Drugim riječima mijenja 

značenje same fotografije pojačavajući tako impresiju cjelokupne kompozicije i 

sadržaja koji postaju dinamičniji i atraktivniji. Tako dobivene fotografije ispunjavaju 

potpuno drugačiji namjenu nego što bi to ostvarivala svaka od ekspozicija zasebno. 

Danas se nakon razvoja digitalne fotografije i njenom modernizacijom ova tehnika je 

proširila svoju namjenu te se počela primjenjivati i u komercijalne svrhe poput modne i 

reklamne fotografije. 
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